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Úvod do 3D dat



Počítačový soubor, případně více vzájemně propojených souborů

digitální záznam
obsahující informace o 
tvaru objektu a dalších 
vlastnostech

zobrazitelný ve 
specializovaných 
aplikacích

Co to je digitální model? 



Trojrozměrná reprezentace skutečného či uměle vytvořeného tvaru ve formě digitálních dat

věrný - reálný upravený smyšlený

Co to je digitální model? 



snadné sdílení
bez ohledu na
geografickou
vzdálenost

široké vizualizační a 
analytické možnosti

animace a 
náhledy

měření a 
analýzy

3D tisk

snadná archivace s ohledem 
na prostorové možnosti, 
hygienické a etické otázky

vs.

Proč 3D modely používáme?

práce s digitálními 
modely ve virtuálním 
prostředí



Open-source program zaměřený na zpracování a editaci polygonálních modelů.

Import: PLY, STL, OFF, OBJ, 3DS, COLLADA, PTX, V3D, PTS, APTS, XYZ, GTS, TRI, 
ASC, X3D, X3DV, VRML, ALN
Export: PLY, STL, OFF, OBJ, 3DS, COLLADA, VRML, DXF, GTS, U3D, IDTF, X3D

+
velké množství nástrojů pro editaci bodových mraků 
a polygonálních sítí jako celku

generování statických náhledů na modely

pracuje s formáty .ply a .obj obsahujícími texturu.

-
časté bugy

omezené možnosti lokálních úprav

MeshLab – základní vlastnosti



File > Import > Import Mesh
nebo přetažením ikony do pracovního okna

Projekt je jednoduchý textový soubor (přípona .mlp), 
obsahuje pouze cesty k jednotlivým modelům, případně 
roto-translační matice, ne už záznamy jejich editace, 
definované body atp!!! V případě, že změníme cestu k 
modelům, projekt nenačteme!!!!!

Seznam importovaných 
objektů a nastavení jejich 
vykreslování.

Obecné požadavky na pojmenovávání modelů:
V cestě ani v názvu modelu nepoužívejte mezery a diakritiku
C:\modely_cviceni\H123_superior.stl

Pokud přejmenujeme vzájemně propojené soubory (např. obj s 
texturou), musíme změnit i odkazy (cestu) v samotných 
souborech.

MeshLab – import dat



Navigace
LMB - otáčení
Ctrl + LMB – posouvání
kolečko myši – přibližování/oddalování
ctrl + h – návrat k originální poloze

LMB + Ctrl + Shift – ovládání osvětlení

shift + kolečko myši – změna FOV (field of view)

MeshLab – navigace

FOV = 7FOV = 90



Nejstručnější formát a zobrazení 3D modelů:

o soubor bodů definovaných trojrozměrnými
souřadnicemi (x, y, z)

o body mohou být opatřeny informací o barvě
o body mohou být opatřeny normálovým

vektorem (určuje rub a líc)

o může být zobrazen
o mohou být měřeny vzdálenosti mezi body
o nevymezuje prostor

bodový oblakRůzné úrovně informace – bodový oblak



o

o

o

o

o

polygonální model (nalevo v umělém zabarvení,
napravo v podobě drátěného modelu)

Různé úrovně informace – polygonální síť



model opatřený
barevnou informací

nestínovaná polygonální síť bez
barevné informace

stínovaná polygonální síť

Podoba závisí na metodě záznamu, editaci modelu a nastavení zobrazení

Různé úrovně informace – polygonální síť a barevná informace



přiřazení barvy přímo jednotlivým prvkům modelu (vrcholům, hranám nebo facetám) ->
závislost detailů zobrazení na rozlišení modelu

5 000 vrcholů30 000 vrcholů70 000 vrcholů

Různé úrovně informace – barevná informace 



přiřazení barvy v podobě tzv. textury

o samostatný obrazový soubor (např. jpg formát)

o barevná informace nezávislá na rozlišení modelu

o nutnost udržovat více propojených souborů (soubor
modelu + soubor materiálu + soubor textury)

Různé úrovně informace – barevná informace 



.obj
o geometrie, barva a materiálové vlastnosti
o barva ve formě informace přiřazené

vrcholům i ve formě textury
o univerzální

Formáty 3D modelů 

obj – soubor nesoucí informaci o samotné geometrii,
obvykle největší
+
jpg – jeden a více souborů s texturou
+
mtl – materiálový soubor specifikující materiálové
vlastnosti modelu a propojující geometrii s texturou



.ply
o geometrie a barva
o barva přiřazená vrcholům nebo ve formě textury

.stl
o pouze geometrie
o dva formáty – Ascii a Binary – Ascii je uspořádanější, binary menší
o pokud polygonální sítě obsahují díry, některé programy hlásí chybu

Formáty 3D modelů 

Existují velmi univerzální programy (např. Blender), ale také programy pracující s velmi
omezeným množstvím formátů (např. Landmark).



PŘESNOST DIGITÁLNÍCH MODELŮ

Míra shody mezi vzájemnou polohou vrcholů
modelu a vzájemnou polohou jim
odpovídajících bodů zobrazovaného objektu

ROZLIŠENÍ

Počet vrcholů modelu na jednotku
plochy (nejčastěji in2 nebo cm2)

DETAILNOST

Velikost rozlišitelných 
prvků

523 vrcholů/cm2

(70 Mb)
2 vrcholy/cm2

(0,2 Mb)

Dáno přesností záznamových metod a
následnými úpravami modelu

Vlastnosti polygonální sítě



60 tis. polygonů/30 tis. vrcholů 5 tis. polygonů/2,5 tis. vrcholů

se zvyšujícím se počtem polygonů modelu stoupá velikost souboru a 
nároky na výpočetní výkon potřebný pro jeho zpracování

Rozlišení je vždy kompromisem mezi technickými 
možnostmi a potřebnou detailností.

Vlastnosti polygonální sítě

počet vrcholů (tis.)

velikost 
souboru (Mb)



Redukce rozlišení může být 
provedena na začátku editace, 
pokud rozlišení modelu klade 
přílišné nároky na výpočetní výkon 
a čas. Zároveň by se mělo 
ponechat co největší, aby bylo 
zachováno co největší množství 
informace pro editační kroky.

Optimal position of simplified vertices – výsledný 
model bude obsahovat pouze vrcholy, které 
tvořily původní objekt. Nebudou generovány 
nové pozice vrcholů na základě algoritmu.

Specifikujeme počet polygonů výsledného 
modelu nebo procento redukce

Preserve Normal, Preserve Topology, 
Preserve Boundary – volby zabraňující 
větším změnám v geometrii modelu. 
Zůstane zachováno směrování polygonů, 
nebudou redukovány výčnělky modelu nebo 
zaplňovány díry.

MeshLab – redukce modelů

o snížení počtu prvků tvořících model 

o sníží rozlišení modelu
o sníží datovou velikost souborů a výpočetní náročnost jejich zpracování

MeshLab – redukce počtu polygonů bez přepočtu textury
(Filters > Remeshing, Simplification and Reconstruction > Quadric Edge Collapse Decimation...)



MeshLab – Redukce počtu polygonů modelů s texturou
(Filters > Remeshing, Simplification and Reconstruction >
Quadric Edge Collapse Decimation (with texture))

MeshLab – redukce modelů



Neexistuje jediná metoda, vhodná pro všechny typy objektů a zaznamenávající všechny vlastnosti!!!

vnitřní strukturavnější tvarbarevná informace

objemové snímání (CT a MRI)povrchové skenery a fotogrammetrie

Snímání 3D modelů



o omezeno na povrch objektů

o primárním výstupem jsou přímo 3D polygonální sítě nebo bodové mraky

o mohou snímat barevnost

o přesnost a rozlišení skenerů jsou dány technickými možnostmi použitých přístrojů  - až 
setiny mm 

Snímání tvaru a barevnosti povrchu

dotykové skenery fotogrammetriespecializované skenery

TOF
triangulační

laserové

pasivní

strukturované světlo



o efektivní metoda pro záznam 
prostorových souřadncie diskrétních 
bodů a křivek na principu fyzického 
kontaktu

o přesný záznam

o použitelné na všechny pevné materiály

o pro snímání živých osob pomalé

Povrchové snímání – kontaktní skenery



o bez fyzického kontaktu s objektem tvoří jeho realistické digitální 
kopie

o mohou snímat barvu

o dobře zaznamenávají povrch kostí i vnější povrch těla (některé)

o nevhodné pro průsvitné a průhledné objekty

Povrchové snímání – bezkontaktní skenery

dotykové skenery fotogrammetriespecializované skenery

TOF
triangulační

laserové

pasivní

strukturované světlo



o měří scénu na základě doby letu laserového paprsku od skeneru k cíli 
nebo změny jeho fáze během této cesty

o používáno pro větší scény (archeologie, památky)

o pro kosterní pozůstatky nevhodné – designováno především pro účely 
mimolaboratorní 3D dokumentace

Povrchové snímání – TOF a fázové skenery



o prostorovou polohu bodů objektu vypočítávají na základě triangulace polohy vůči dvěma a 
více triangulačním bodům (dvě a více kamery, projektor a kamera)

o povrch musí být triangulován – musí být dostupný z obou referenčních bodů

Povrchové snímání – triangulační skenery



o promítají jednu či více linií a z druhého bodu snímají deformaci jejich 
obrazu na povrchu objektu

o rozlišení až v řádu setin mm 

o záznam zpravidla v řádu jednotek či desítek sekund

o v Lamorfě skener NextEngine

Povrchové snímání – triangulační skenery – aktivní laserové skenery



o promítají komplexní obrazce

o rozlišení až v řádu desítek mikrometrů 
(obecně detailnější než laserové)

o záznam v řádu sekund

Povrchové snímání – triangulační skenery – aktivní skenery se strukturovaným sv.



Povrchové snímání – triangulační skenery – pasivní/optické skenery

o triangulují prostorové souřadnice z dvou a více snímků, pořízených 
synchronizovanými kamerami z různých úhlů

o rozpoznávají specifické prvky na fotografiích, ztotožňují je a z rozdílů v 
jejich vzájemné pozici na jednotlivých snímcích počítají jejich 3D 
souřadnice

o velmi rychlé, designováno především na snímání živého člověka



o přenosná alternativa obličejových a celotělových skenerů

Povrchové snímání – triangulační skenery – pasivní/optické skenery



Povrchové snímání – triangulační skenery – pasivní/optické skenery

o soustavy synchronizovaných fotoaparátů



Povrchové snímání – triangulační skenery – pasivní/optické skenery

o přístroje konstruované pro snímání různých detailů



o generování 3D dat ze série fotografií pořízených 
fotoaparátem z různých úhlů

Povrchové snímání – fotogrammetrie



o vysoká míra flexibility
o přesnost srovnatelná se skenery
o pouze na stabilní objekty s 

povrchovou texturou

Povrchové snímání –fotogrammetrie



o metody zaznamenávají rozložení hmoty ve snímaném objemu 

o záznam vnitřní struktury, vnější podoby, ale ne barevnosti

o relativně velké a finančně náročné přístroje (umístění, personál atd.)

výpočetní tomografie

Objemové snímání



o produktem je objemový záznam!!!, ze kterého se 3D modely musí vytvořit

Objemové snímání

o primárním jednotkou záznamu jsou voxely, části objemu rozdělující snímaný prostor do 
pravidelné trojrozměrné sítě

pixely
voxely (Aremu et al. 2017)



Objemové snímání

o metoda měří danou charakteristiku v objemu voxelu (dále nedělitelného) -> 256 odstínů šedi

o počet voxelů pro daný objem je dán technickými možnostmi skeneru a jeho nastavením 
(matice např. 512 x 512; 2048 x 2048) 512

512
512

512

lepší rozlišení jen při menším objemu



o měří pracovní pole pomocí rtg paprsků –
ionizující a potenciálně nebezpečné

o běžné lékařské přístroje rozlišení do ca 0,35 
mm, specializované uCT a nanoCT až do 
desetin mikrometru

Kováčová 2016
jazylka
CT, voxel 0,01mm

Výpočetní tomografie



Objemový záznam  - výpočetní tomografie



o obecně velmi dobrý kontrast pro kosti bez měkkých tkání i 
kosti kryté měkkými tkáněmi a jinými překážkami (ne kov)

o obecně špatný kontrast pro měkké tkáně

o kov může být zdrojem artefaktů 

(Harvig et al. 2012)

Výpočetní tomografie



o záznam na principu změn spinů elektronů v 
magnetickém poli

o běžné rozlišení až 1 mm, speciální přístroje pak desetiny 
milimetru

o nejlepší kontrast pro látky obsahující různé podíly vody 
a tuku – měkké tkáně

o kosti často špatný kontrast

Magnetická rezonance

CTMRI



Výstup objemového snímání



o objemová data se dají zobrazit jako tzv. multiplanární projekce nebo s pomocí metod 
objemového zobrazení

o pořád nejde o polygonální modely

multiplanární
projekce

Výstup objemového snímání



Objemové snímání - segmentace a renderování



o

o

Objemové snímání - segmentace a renderování



Objemové snímání - segmentace a renderování



Odstranění nežádoucích částí funguje podobně jako mazání v programech pro editaci
fotografií. V prvním kroku jsou výběrovými nástroji označeny části modelu a ve druhém jsou
vymazány.

K označení polygonů a vrcholů pro jakoukoliv editaci 
slouží nástroje:

MeshLab – odstranění nežádoucích částí modelu

„Select vertexes“ a „Select
Faces in Rectangular
region“ – výběr vrcholů, 
resp. facet rámečkem

„Z-Painting“
freehand výběr prvků sítě

„Select connected
component“ –
výběr celé 
navazující 
polygonální sítě

„Select
faces/vertices in… “ 
– výběr prvků 
pomocí mnohostěnu



1) aktivujeme nástroj

2) LMB nebo RMB vyznačíme polygon 

3) Q vybereme prvky

při aktivovaném nástroji
T – přepíná mezi výběrem bodů a facet
BACKSPACE – zruší poslední bod mnohostěnu
W – odznačí prvky v mnohostěnu
I – invertuje výběr
….

MeshLab – odstranění nežádoucích částí modelu – výběr



MeshLab – odstranění nežádoucích částí modelu – výběr

1) aktivujeme nástroj

2) v dialogovém okně vybereme nástroj výběru

3) LMB přidáváme výběr
RMB odebíráme výběr

při aktivovaném nástroji
backfaces – při aktivaci nástroj vybírá i facety, 
které jsou lícovou stranou natočeny k nám 
rubem
hidden polygons – při aktivaci vybírá i facety, 
které nejsou vidět, například proto, že jsou kryté 
jinými částmi modelu
…. dobré pro dočištění… !



MeshLab – odstranění nežádoucích částí modelu – odstranění

Program dovoluje odstranit různé prvky modelu.

odstraní všechny vrcholy a 
všechny facety, které označené 
vrcholy definují – nebude 
fungovat, pokud jsou vybrány 
pouze facety!

odstraní všechny facety 
– nebude fungovat, 
pokud jsou vybrány 
pouze vrcholy (mohou 
zůstat vrcholy)

odstraní všechny facety 
a jejich vrcholy, které 
obklopují



Measuring tool

1) kliknutím LMB na model určíte krajní body 
vzdálenosti

Pokud je potřeba změnit mezi umístěním prvního a 
druhého bodu pohled, pak se z nástroje přepíná 
stiskem Esc nebo ikonou 

2) nástroj zobrazí hodnotu přímé vzdálenosti bodů

Při opětovném použití přibývají další rozměry.

MeshLab – měření a škálování modelů



MeshLab – měření a škálování modelů

Škálování

1) změřte referenční vzdálenost na modelu

2) vydělte skutečnou referenční vzdálenost naměřenou 
vzdáleností

3) o získaný koeficient zvětšete nebo zmenšete model

Filters > Normals, curvatures and orientations >
Transform: scale…

uniform scaling – velikost změněna 
stejně ve všech třech dimenzích –
nedochází ke změně tvaru

freeze matrix – dojde rovnou k 
přepočtu modelu, bez rototranslační
matice



Export polygonálních modelů 
File > Export Mesh...

o změny modelu nepřepisují hned původní soubor
o změněný, ale neuložený model je v Layer Dialog onačen 

hvězdičkou
o pro změnu souboru modelu musí být změněný model 

exportován

Zadáme formát souboru a umístění

MeshLab – export dat

Nastavení součástí 
exportu
TexCoord – zásadní pro 
zachování textury!



MeshLab – Manipulators Tools
o T, R, S – zvolíme požadovanou transformaci
o transformujeme při stisknutém LMB
o transformaci potvrdíme Enter

Transformací je na objekt aplikována tzv. roto-transformační matice

o každý model je umístěn na konkrétním místě vzhledem ke svému souřadnicovému
systému (dáno hodnotou souřadnic vrcholů modelu)

o při změně pohledu (LMB atd.) se pohybuje kamerou!, poloha modelu vůči souřadnicové
ose se musí změnit k tomu určenými nástroji

MeshLab – transformace modelů



Matice jsou součástí projektu MeshLab. Při načtení je objekt podle ní orientován, 
ale samotné souřadnice jeho vrcholů zůstávají nezměněny!!! 

proč? – například proto, že se při smazání matice „vrátí“ do původní polohy 

Aby se změnil samotný model, musí být na něj matice apikována!!!
o LMB na název objektu v Layer Dialog > Freeze Current Matrix (některá 

dialogová okna toto nabízejí rovnou)
o některé funkce (např. záznam souřadnic bodů) bez aplikace rototranslační

matice nefungují

MeshLab – transformace modelů

o model je zobrazován s aplikovanou rototranslační maticí



Export náhledového okna ve formě obrázku (bitmapa)
1) nastavíme požadovaný náhled v pracovním okně

2) otevřeme dialogové okno Save snapshot

cílový adresář

název souboru

Nastavení rozlišení výsledného snímku v 
násobcích rozlišení náhledového okna

MeshLab – vytváření náhledů

nastavení pozadí



MeshLab – záznam 3D souřadnic bodů

1) spustíme nástroj PickPoints

2) body umisťujeme kliknutím 
RMB na model

tyto volby slouží pro 
uložení a tvorbu šablony, 
do které se body zanášejí

tyto volby slouží pro 
uložení a nahrání 
souřadnic

tyto volby slouží k 
editaci zaznamenaných 
dat (názvů jednotlivých 
bodů)

nastavení viditelnosti a 
způsobu zobrazení normály


